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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for the devices that are used in the
system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. Model Manual name

OMRON 1610-E1 Model CK3E-11710 CK3E-series Programmable
Multi-Axis Controller Hardware
User’s Manual

OMRON 0036-E2 Model CK3M-CPU1[11 CK3M-series Programmable
Multi-Axis Controller
Hardware User’s Manual

OMRON W580-E1 Model Industrial PC Platform NY-series
NY512-A6001XX21391X | IPC Programmable Multi-Axis
Controller Industrial Box PC
Hardware User's Manual

OMRON W488-E1 Model GX-IDOOOO EtherCAT® Slave Units User’s
Model GX-ODOOOO Manual

Model GX-OCcO O OO
Model GX-MDOO OO
Model GX-ADOO OO
Model GX-DAOO OO
Model GX-ILMO O
Model XWT-IDOOOO
Model XWT-ODO O OO

DT 0014-E - Power PMAC User’'s Manual
DT 0O015-E - Power PMAC Software Reference
Manual

DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and I/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which Process Data Objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in real time.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESlI files into the Power PMAC IDE, to easily allocate
slave process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) 1t is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.

(5) The information contained in this document is current as of April 2019.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property

/A WARNING

damage.

f C t Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to connect the OMRON EtherCAT Remote 1/O
Terminal model GX-OJOOOOO (hereafter referred to as the Slave) using OMRON
Programmable Multi-Axis Controller model CK3E-O OO O/CK3M-CPU1L1/NY510-A0 00
(hereafter referred to as the Controller) and EtherCAT, as well as for checking the connection.
Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT.



5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices
The applicable devices are as follows:

Manufacturer Name Model

OMRON Programmable Multi-Axis Model CK3E-OJOO0O
Controller

OMRON Programmable Multi-Axis Model CK3M-CPU1[11
Controller

OMRON Programmable Multi-Axis Model NY510-AC0O0O
Controller Industrial Box PC

OMRON EtherCAT Remote I/O Terminal Model GX-LIOOIOOO

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration
The hardware components to reproduce the connection procedures in this document are as

follows:

Model GX-ID1611
Model GX-OD1611

4

Power PMAC IDE Model NY510-AO000

EtherCAT
communications

Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model NY510-A000 | Ver.2.5 or later
Controller
. Model GX-1D1611
OMRON EtherCAT Remote I/O Terminal Model GX-OD1611 Ver.1.1
OMRON Ethernet cable (with industrial Model
Ethernet connector) XS5W-T421-CIMOI-K
DT Power PMAC IDE - Ver.4.2.1.19

El Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information
This document describes model NY510-AC0 O as an example. The same procedures can
apply to model CK3E-LIO O L/CK3M-CPULLI1.

©



6. EtherCAT Connection Procedure

This section describes the procedure for connecting the Controller with the Slave via
EtherCAT. The description assumes that the Controller is set to factory default.

I 6.1. Workflow

Take the following steps to operate the PDO communications via EtherCAT after connecting

the Controller with the Slave via EtherCAT.

6.2 Preparation for the Controller Setup

v

6.2.1 Creation of a New Project

v

6.2.2 Initial Settings of the Controller

v

6.3 Installation of ESI Files

v

6.4 EtherCAT Communications Setup

v

6.4.1 Communications Setup for the EtherCAT Master

v

6.4.2 Distributed Clock Setup

6.4.3 PDO Map Settings

v

6.4.4 Creation of an EtherCAT Network Information

File
v
6.5 Controller Settings

v

6.5.1 EtherCAT Communications Check
v

6.5.2 Writing the User Program
v

6.5.3 Project Data Transfer

10

Prepare the Controller settings.

Install the ESI file for the Slave into
Power PMAC IDE.

Set up EtherCAT communications.

Set up the Controller.



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.
Install Power PMAC IDE and Acontis EC-Engineer on the computer in advance.

6.2.1. Creation of a New Project

Turn on the power to the
1
Controller.

2 Start Power PMAC IDE.

* |f the dialog for confirming [d

access rights appears upon F":"-""';BPE""”*'-':

start-up, select starting of Power
PMAC IDE.

3 The Communication screen
appears. Specify the IP address
of the destination Controller and
click Connect.

@ IDE Envircnment - O >

Communication

=210

IP Address 192.168.0.200 w

Paort 2
Pratacal 55H
* The IP address of the Lser root
. Paszword L 1 2 2 1117}
Controller is set to Select Device AtStartup True
“192.168.0.200" by default.
* If necessary, change the
Windows IP address to IP Address

“192.168.0.X". Set IP Address

Connect Last Session IP Mo Device

For detailed setup options go to Tools menu -> Options
-> PowerPMAC

11



4 Power PMAC IDE starts, and is
online to the Controller. :_-“3“?‘1-_"':’{;-; e T —————— T

& Bttt o | Bt 0 B T et T [ o | ] e [ i T T

[T —— Paen e Fatening Srvar TR
Syetanatzant amian 1 P [T o 2
Sytaritered " m e o

- am B om

Frweriha Conliquration Workfiow

e

@ roverrMac i

5 From the File menu, select New

then Project. @ Povermacioea211 ([

File | Edit View Debug Tools DeltaTau EtherCAT  Window  Help
New * |3 Project.. Ctrl+Shift+N
Open * | File. Ctrl+N I

Close "
Position

Close Solution
. Position

Upload Project From PowerPMAC

l  Save Selected ftems Ctrl+S
Save Output As...

¥ Saveall Ctrl+Shift+S
Export 3
Import

[ie}

Page Setup...
= Print... Ctrl+P

Recent Files

Recent Projects and Solutions 3

B Exit Alt+F4

6 Enter a project name and
location, and select OK. [

¥ Reiest Sart by Detautt v

= _q PowarMAC PowaPMAT Type: PowerPMAC
PewerPMAL g A b PermerPMAL prejest '

PrawerhAC Solution Pesar@MAL with EERrCAT [Acsetie] PowaPAAL

PawerBrick ¥ e BMAC

ame: PowerFMACS

g T

Location:
Sohation name PowePMACS

[ Jox || conen

12



6.2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary
data in advance.

i werPMACS - Powe 2110 (N

In the Terminal tab page, type B rouaryiacs: poveplAC DE42LLS
File Edit View Project Build Debug Tools DetaTau £
the $$$*** command to reset the === & - tEE 0o o

i & StartPage ¥ Communication Setup | ] Terminal €} Position

‘Watch Window

Controller to factory default.

c Query

Sys.ServoCount 2764277 -
Sys.ServoPeriod 1

ECAT[0].Enable 0

Motor[1].5ervoOut 0

Motor[1].Pos5f 1

Terminal

terminal

;;;;;

2 Select System — CPU — System
in the Solution Explorer.

Solution Explorer >~ 1 x
W o-alp -

Search Solution Explorer (Ctrl+:) P
] PowerPMACS -
4 [ System

4 [z CPU

C3 Hardware

3 EtherCAT

3 Motors

[[4 Coordinate Systems
b [ Encoder

b [ C Language
b 3 Configuration
b [ Decumentation
b [ Log =

Solution Explorer

3 Select Global Clock.

i

PU Settings

Structers flaments

‘ Glokal Clock | Commanly Used

Asvanced View




4 Specify Servo Frequency.

Global Clock Settings

Select the Servo Frequency

setting from 4 kHz, 2 kHz, or Phase Frequency : Kz
1 kHZ Servo Frequency kHz

* Servo Frequency is set to
1 kHz for the example in this
document.

5 Click the Accept button.

Mew clock  PowerPMAC
Items )

settings Value
Servo Period (msec) 1.000 1.000 -

EtherCAT option detected and no Master Gate -
detected, using internal clock by setting

. ays.CPUTimerlntr = 1. For EtherCAT the
ServoPeriod must be multiple of 62.5 usec. On
Accepting the clock issue save and type $55 in -

= Commonly Used Structure Elements [ Accept

6 If you have changed the servo Termingl
frequency Setting, type the save DAVITIY |0 T LS -ZYTICINIY 1S W a5
command in the Terminal tab Saving To Flash: Mounting the flash
page of Power PMAC IDE. Saving To Flash: Finished SAVING to flash
When complete, the “Save
Complete” message appears in
the Terminal tab page.

Save Completed

~7 Click Delta Tau — @ rovermiacs - roverpvac e 42129 [
. . File Edit View Project Build Debug Tools Delta Tau EtherCAT
Communication Setup on the
toolbar to display the Device

Properties dialog box.

| i il [ -0 <[ pebug -/ Am
i @ start Pagefl » Communication Setup | 5] Terminal € Position Watch

Watch Window

Command/Qu
Sys.ServoCount] ’ Test l [ Apply ]
ECAT[O].Enabig b
4 Device -
ECAT[OI-Enablﬂ | P Address 192.168.0.200
Fart 22 £
ECAT[0].Enable] Protocal 55H
i Lizer root -
Sys.ServoPeriod P Address |E
Set IP Add
Sys.ServoDeltaTf| i ress
Sys.FltrservoTiff|

Sys.MaxServoT

Cue MinCanmTimea 1 ATINANANNNNNNNNNE




-
@ Device Properties

8 In the Device Properties dialog
box, select No Device for IP l st ] Aoply
Address, then click the Apply —
button. + Dovice "
IF Address
Port =
This operation sets the Protocal SSH L
i Lizer root o
Controller to the offline state. - S ————
IP Address
Set IP Addreszs
E ﬂ
o] Restart the Controller.
The servo frequency that has
been set is reflected.
10 Wait until the startup process of (@ Device Properties =)
the Controller is complete. Then [ Teat ] Anply

click Delta Tau —
Communication Setup on the
toolbar to display the Device
Properties dialog box.

In the Device Properties dialog
box, return the IP Address to the
previous setting, then click the
Apply button.

This operation sets the
Controller to the online state.

IP Address
Fart
Protocal
Lizer

IF Address
Set IP Address

L3

192.168.0.200

S55H

4 [.m

|—"

15



I 6.3. Installation of ESI Files

Install the ESI file for the Slave into Power PMAC IDE.

m Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

From the EtherCAT menu of
Power PMAC IDE, select ESI
Manager.

. PowerPMACS - PowerPMAC IDE 4.2.1.19 g 1p: 192.168

File Edit View

|8 -

Project Build Debug Tools

AR AN

Delta & i

e e
- ‘ Ofbug [ ESI Manager

P Start -

© @ StartPage # Communication Setup | 5=] Terminal ¢} Postion @] watd atus og Ribbon | ] Tas
Watch Window

Sys.ServoCount

Command/Query

# ~ I X || Position
Response Position
577552 = E31
#2

ECAT[0].Enable=1

Confirm that Omron GX-Digital
10.xml is registered in the ESI
file list of ESI Manager.

If it is not yet registered, click
Add File and register Omron
GX-Digital 10.xml

ESI Files

Selact an ESI file which should be deleted or exported or add new ESI files.

&  Defta Tau Data Systems, Inc.
I | Omron Corporation

Omron 3G3AX-MX2-ECT.xml

Dmran 3EIAY-RY-ECT v

Add Folder

-
= Add ESI File

@J\ V Computer + Removable Disk (F) + ESI
/) E

Number of ESI files: 41

MNumber of devices: 360

Organize =

't Favorites
P Desktop
& Downloads

%] Recent Places

3 Libraries
¥ Documents
& Music
&) Pictures

B videos

1% Computer
&, Local Disk (C3)
s Local Disk (D7)

= Removable Disk |

€ Network

New folder

* Name ’

Orran GX-Digital I0.xml

| Omron NX_Couplerxml
£ Omiron RE8D-15Nxoc ECTaxml
) Omron RE3D-Khboa-ECT

=)
= \ 44 H Search ES! k]
- -
- 0 @

Date modified Type Size
11/16/2012 342 PM XML Document 9114 kg
2/21/20181205PM XML Document 5,491 KE
1/21/2013849 PM XML Document 19,229KE
11/16/2012 343PM XML Document 14,683 K8

e

Fi

] 3

name: Omron GX-Digital I0.xml

3 Click Close to close the ESI
Manager page.

+ | SupportedFiles (amb*zip)

I 6.4. EtherCAT Communications Setup

Set up EtherCAT communications.
16



m Precautions for Correct Use

Before taking the following steps, make sure that the devices are connected via an Ethernet

cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet

cable.

6.4.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with
slave devices using an Ethernet
cable.

* Refer to the manuals for slave
devices to configure them.

2 Select System — EtherCAT in
the Solution Explorer and
right-click on EtherCAT, then
select Add EtherCAT
Master(Acontis).

Solution Explorer
W o-F| p--

Search Solution Explorer (Ctrl+:)

0.00 rev
] PowerPMACS
0.00 rev
4 |7 System
0.00 rev b [ CPU
[ Hardware
0.00 rev
Scope to This 3 Motors
New Solution Explorer View [ Coordinate Systems
M Properties Alt+Enter (3 Encoder

C Language
Cenfiguration

F= Nnenmantatinn

Add EtherCAT Master (Acontis)

b

3 MasterO (Deactivated) is added
to Solution Explorer.

Solution Explorer * 1 x
W o-a|Fp -
Search Solution Explorer (Ctrl+:) R~

1 PowerPMACS
4 [ Z System
P [ CPU
[ Hardware
4 [= EtherCAT
| & Masterd (Deactivated) |
3 Motors
1 Ceordinate Systems
I [ Encoder
[ C Language
1 Cenfiguration
1 Documentation
£3 Log
[C3 PMAC Script Language

v v v v W

17



4 In the Master tab page, specify
a communication period for
Cycle Time [us].

* You must specify the
communication period in
accordance with the servo
frequency of the Controller.

1000 us is set in this document.

estro eaczvared) - [

Device Editor

Master |Topology View

General
Unit Name EtherCaTSuite Master
| Cycle Time [us] ‘1000 -

Slaves connected to local system

Network Adapter O—7HJL TU 748 5 ( Intel(R) 1210

Slaves connected to remote system

IP Address 192 (168 . 0 200
Port 6000
Master-Instance 0
Networks: 1 | Slaves: 0 | | state: | Mode: CONFIG

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

4 kHz : 250 us

2 kHz : 500 us

1 kHz : 1000 us

5 Select System — EtherCAT in
the Solution Explorer and
right-click on Master0
(Deactivated), then select
Scan EtherCAT Network.

Solution Explorer
@ o-a|rp -

Following Error

0.00rev = Search Solution Explorer (Ctrl+:)
0.00 rev 1 PowerPMACS
i 4 [ System
0.00 rev b [3 CPU
[3 Hardware
0.00rev

4[5 EtherCAT

Configuration Mode ors

Diagnosis Mode rdinate Systems

I Scan EtherCAT Metwork I pder
uage
Append Slave ration
Paste Slave Ctrl+V entation

Import Slaves from ENI
script Language
Export ENI File

Load Mapping to PowerPMAC

Load Mapping to PowerPMAC From ENI

Activate EtherCAT

=@ Class View

ctivated) File Pro

Edit Topology

EoE Endpoint Configuration
¢ Open

Scope to This

jense Moto
B¢ MNew Solution Explorer View Masi
Properties Alt+Enter Ci¥l

p

18



6 Make sure that the slave is
displayed in the Solution
Explorer.

Solution Explorer - I x
@ o-g| F =

Search Solution Explorer (Ctrl+:) P

1 PowerPMACS
4 | System
3 CPU
[ Hardware
4 | EtherCAT
4 [ master0 (Deactivated)
o= Slave_1001 [GX-ID1611] {1001)
o= Slave_1002 [GX-0D1611] (1002)
Ca MoErs -
[[3 Coordinate Systems
4 Encoder
[ C Language
3 Configuration
Cd Documentation
[dLeg
3 PMAC Script Language

vV Vv v v

Solution Explorer EelRE-RUE

19



6.4.2. Distributed Clock Setup

1 In the Project Explorer, select

Solution Explorer

the target slave GX-ID1611 to S| o-a|p =

d|sp|ay the Advanced Options Search Solution Explorer (Ctrl+:) P
1 PowerPMACS -

tab page' 4 [ System
b3 CPU

4 Hardware
4[5 EtherCAT

4 & Mackard (Masctiabad
ave_100 A-0D1b 00
[ Motors
[ Coordinate Systems
I [ Encoder

P [3 CLanguage 7
Solution Explorer

Device Editor

| General ” PDO Mapping " V‘amab\et- | Advanced Options |In|- Commands " CoE Object-Dictionary " Sync Umts‘
-
Process Data Mode Overwrite Mailbox Size
Disable LRW [C] Output Size:
[C] Input Size:

Overwrite Watchdog

Set Multiplier (Reg.: 0x400): 2498 =
Set PDI Watchdog (Reg.: 0x410): 1000 (5 (100.000 ms)
Set SM Watchdog (Reg.: 0x420): 1000 % (100.000 ms)

Distributed Clocks
[C] Potential Reference Clock

-

4 »
Networks: 1 | Slaves: 2 | State: @ & | Mode: CONFIG
2 Inthe Advanced Options tab Slave_1001 [GX-ID1611] (1001) + X
page, clear the Potential Device Editor
Reference Clock check box. ' General | PDO Mapping | \I‘Eriahles‘ Advanced Options | Init Commz

Distributed Clocks
[7] Potential Reference Clock

3 In the same manner, clear the
Potential Reference Clock
check box for GX-OD1611.

|§ Additional Information

Remote 1/0 Terminal model GX-LJOUOIOL does not support DC Mode.
Disable the reference clock by taking the steps shown above.

20



6.4.3. PDO Map Settings

1 In the Solution Explorer, select
the target slave
[Slave_1001[GX-ID1611] Jand
display the PDO Mapping tab
page.

Solution Explorer

W o-a|r -
Search Solution Explorer (Ctrl+:)

1 PowerPMACS -
4 [ System
p [ CcPU
3 Hardware
4[5 EtherCAT

Pl 1 : o
o Slave_1001 [GX-ID1611] (1001)
[ OOz Lo UDIoIT] 1o02)

[ Motors
[ Coordinate Systems
b 3@ Encoder

P [ C Language &
Solution Explorer

Device
Genera\l PDO Mapping Ivarlab\es ” Advanced Options || Init Commands || CoE Object-Dictionary ” Sync umt5|

Inputs Outputs

257th transmit PDO Mapping (  Ox1BOO -
Name Index Bit Length
Read input 15 | 0x6100:01 16
258th transmit PDO Mapping 0x1B01
Name Index Bit Length
Input Bit0OO 0x3020:01 1
Input Bit01 0x3020:02 1 -

Add Delete Edit Up Down

Networks: 1 | Slaves: 2 |

| state: @ @ | Mode: CONFIG

2 Check Inputs to make sure that
only the 258th transmit PDO
Mapping 0x1B01 check box is
selected.

Slave_1001 [GX-ID1611] (1001) + X

Device Editor

eneral

Inputs

C

PDO Mapping |Variables " Advanced Options "
257th transmit PDO Mapping (excl Ox1B00
2538th transmit FOO Mapping Ox1B01
|:| 512th transmit FOO Mapping Ox1BFF

21



3 In the Solution Explorer, select
the target slave
[Slave_1002[GX-OD1611]] and
display the PDO Mapping tab
page.

Solution Explorer > 1 x
@ o-alp -

Search Solution Explorer (Ctrl+:) P i
1 PowerPMACS -
4 [ System

P 3 CPU
[J Hardware

4 |5 EtherCAT
4 & Master0 (Deactivated)

[3 Coordinate Systems
Solution Explorer

Slave 1002 [GX-0D1611] (1002) + X

Device Editgr
| General ||F’DCI Mapplnj |Variables ” Advanced Options ” Init Commands || CoE Object-Dictionary || Sync Units

Inputs Outputs
|:| 512th transmit PDO Mapping 0x1BFF 257th receive PDO Mapping (e 0x1700 -

Name Index Bit Length Name Index Bit Length

Sysmac Error ! 0x2002:01 8 Write output | 0x6300:01 16

258th receive PDO Mapping 0x1701
Name Index Bit Length
Qutput Bit00  0x3220:01 1

Qutput BitD1  0x3220:02 1 =

Add Delete Edit Up Down

Networks: 1 | Slaves: 2 State: & @ | Mode: CONFIG

4 Make sure that the check box in
the Inputs field is not selected.

Inputs {

|:| 512th transmit PO Mapping O0x1BFF

Name Index Bit Length

Sysmac Error ! | Ox2002:01 8

5 Make sure that only the 258th
receive PDO Mapping 0x1701
check box is selected in the
Outputs field.

Outputs

257th receive PDO Mapping (exclu  Ox1700

258th receive PDO Mapping Ox1701

6.4.4. Creation of an EtherCAT Network Information File

22



Solution Explorer -
& o-8|p -

Search Solution Explorer (Ctrl+:)

1 Select System — EtherCAT in
the Solution Explorer and
right-click on Master0
(Deactivated), then select Load

7] PowerPMACS
4 [ System
P 3 CPU
[J Hardware
4[5 EtherCAT
e ster() (Deactivated)

Mapping to PowerPMAC.

Configuration Mode

Diagnosis Mode

Scan EtherCAT Network

Append Slave

Paste Slave Ctrl+Vv

Import Slaves from ENI

Slave_1001 [GX-ID1611] (1001)
Slave_1002 [GX-0D1611] (1002)
3
hate Systems
er

ige

ition
stom_save.cfg

Export ENI File
ﬁ m—
Load Mapping to PowerPMAC

om_save.tpl
hable.txt

PoTg
Activate EtherCAT
Edit Topology
EoE Endpoint Configuration
¢ Open
Scope to This
B! New Solution Explorer View

Alt+Enter

. _disable.txt
._startup.txt
e.cfg
rtup.txt
setup.cfg
itation

ipt Language
Includes
bal definitiens.pmh

Fir RaiFinac

2 An eni.xml file is added under

the Configuration directory in
the Solution Explorer.

A Properties
I ————
Solution Explorer -1 x

@ o-als =
Search Solution Explorer (Ctrl+:) P~

] PowerPMACS
b [ System
b [ C Language
4 [ Configuraticn
[ ECATConfig.cfg

B enixml
[0 pp_custom_save.cfg
[ pp_custom_save.tpl
=] pp_disable.txt
=] pp_inc_disable.txt
=] pp_inc_startup.bxt
O pp_save.cfg
=] pp_startup.txt
[0 systemsetup.cfg

b 4 Documentation

b [aLog

P [3 PMAC Script Language

Solution Explorer

3 An ECATMap.pmh file is added

under the PMAC Script
Language/Global Includes
directory in the Solution
Explorer.

Solution Explorer > I x
@ o-ar -
Search Solution Explorer (Ctri+:) L~

] PowerPMACS

b [ System

[3 C Language

3 Configuration

L3 Documentation

3 Log

= PMAC Script Language

4 [ Global Includes

global definitions.pmh

[ ECATMap.pmh
3 Kinematic Routines

[ Libraries

B[4 Motion Programs

B [ PLC Programs

[

I 6.5. Controller Settings




6.5.1. EtherCAT Communications Check
Take the following steps to ensure that EtherCAT communications are available.

1 From the Terminal tab page, run
the ECAT[0].Enable=1
command to start EtherCAT
communications.

Terminal

00 successful

ECAT[D].Enable=1|

2 In the Terminal tab page or Watch Window

Watch Window, make sure that
the ECATI[0].Enable value turns
to 1.

Command/Query Response
Sys.ServoCount 12960793

*The OP mode is entered and
EtherCAT communications are
established.

3 After making sure that correct
communications are available, : ) P
) erminal

run the ECAT[0].Enable=0 to start communication

'MAC at 1921

command from the Terminal tab
page to stop EtherCAT
communications.

ECATI0].Enable=0|

4 In the Terminal tab page or
Watch Window, make sure that

the ECATJ[0].Enable value turns
to 0 Sys.ServoCount 13312872

Watch Window

Command/Query Response

ECAT[0].Enable

6.5.2. Writing the User Program
Create programs to be used to check operations.
A specific language is used for the operation check programs. Refer to Power PMAC User’s
Manual and Power PMAC Software Reference Manual for details.
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1 In the Solution Explorer pane,
open Project name — PMAC
Script Language — PLC
Programs — plcl.plc.

plcl.ple & X Solution Explorer

,:,: Power P.‘MCISc’ipt PLC Program Tern?late‘ + m' o - | =

/f The following Sample PLC PROGRAM is the st a

// Sample PLC PROGRAM Search Solution Explorer (Ctr 0 ~
/

// open plc 1 ] PowerPMACS

S e User Code Goes Here--- P 3 System

close

I [ CLanguage

B 3 Configuration
P [d Documentation
[

F

, =
|
[ Log
[ PMAC Script Language
I [ Global Includes

[d Kinematic Routines
I [ Libraries
b [ Motion Programs

4 = P Program

[ plcl.plc

100% - 4 b Solution Explorer

2 In the programming area of the
plcl.plc tab page, write a
program as shown on the right.

This sample program blinks the
GX-0OD1611 output indicator
every second.

* In this example, PDO mapping
is assumed to be the default
setting. If you want to change
PDO mapping, rewrite the
“Slave_1....” description.

open plc 1
while(sys.ecatMasterReady==0){};
ECAT[0].Enable=1;

P1000 = Sys.Time + 1;
while(P1000 > Sys.Time){}
Slave_1 3220 1 OutputBit00 = 0;
P1000 = Sys.Time + 1;
while(P1000 > Sys.Time){}
Slave_1 3220 1 OutputBit00 = 1;

close

3 Setting the start of the user
program

In the Solution Explorer pane,
open Project name —
Configuration —
pp_disable.txt.

pp_disable.txt +® x olutio 0
11k //Kill all the motors (This o m‘ -
&% //Abort All Programs -

disable plc @..31 //Disable all Script PLCs Search Solution Explorer (Ctrl+ O ~

clear all buffers

1 PowerPMACS
—f b [3 System
b [ C Language
4[5 Configuration
[ ECATConfig.cfg
2] enixml
[ pp_custom_save.cfg
p_custom_save.tpl
= pp_Inc_disable.tx
=] pp_inc_startup.txt
[ pp_save.cfg
=] pp_startup.kxt
[ systemsetup.cfg
P [ Documentation
b [J Log
B [ PMAC Script Language

W0% - 4 » Solution Explorer
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4 In the programming area of the
pp_disable.txt tab page, add the enable plc 1;
program shown on the right to

the last line.

The pp_disable.txt program is
automatically executed when the
Controller starts.

This example program runs the
PLC1 script.

6.5.3. Project Data Transfer
Transfer the created project data to the Controller.

/A WARNING

When the user program and “configuration and setting” data are transferred
from Power PMAC IDE, devices or the machine may perform unexpected
operations.

Therefore, before you transfer project data, ensure the destination slave is
operating safely.

Transferring project data restarts the Controller and interrupts communications
with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.

Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.

1 In the Terminal tab page or
Watch Window, make sure that
the ECAT[0].Enable value is 0.

Watch Window

Command /Query Response
Sys.SernvoCount 13312872
If the value is 1, run the ‘ ECAT[0].Enable

ECAT[0].Enable=0 command

from the Terminal tab page to
stop EtherCAT communications.




2 Downloading a project Felvi Bl - 0 x

W o-a|p -

Search Solution Explorer (( O ~

PowerPMACS

Right-click the project name in
the Solution Explorer pane on

¢y Build 1 System
the upper right of the IDE Rebuild 3 C Language
. Clean 1 Configuration
screen, and select Build and £3 Documentation
| d All Mew Solution Explorer View 1 Log
Download All Programs to run I- Build and Download All Programs PMAC Script Language
the build and download. ™ap PMAC variables

Add Macro Project
Export Project with IP Protection...
Export Project Template...

* The transferred project is not ¥ cut ctri+X
yet saved to the Controller at this Walives Pyess
Stage ¢* Open Folder in File Explorer
. M Properties Alt+Enter
If you turn OFF the power to the e et . D—

Controller, the transferred
project will be discarded.

3 Make sure that there are no
errors in the Output Window.

* If the transfer fails, check
details of the error in the Output
Window.

If the error is a program error,
you must review the program.

If the error is related to
EtherCAT settings, return to 6.4
EtherCAT Communications
Setup and check whether there
are any incorrect settings.




4 The program starts running
when it has been downloaded
successfully.

EtherCAT communications are
in the OP state. enable plc 1

Vary the GX-ID1611 input and [ T LT R I TLETR Terminal _

make sure that the variable

P1001 changes in the Terminal
or Watch pane.

* If the variable does not
change, check that the
ECAT[0].Enable value is 1 in the
Terminal tab page or Watch
Window.

If the value is 0, run the following
command from the Terminal tab
page.

enable plc 1

5 After you have confirmed an
appropriate operation, save the
project to the Controller.

Terminal

Available disk spac
Required disk sp:
Saving To Flash: Syncing files to flash

Run the save command from the Saving To Flagh: Mounting the flash

Terminal tab page. e o -
Saving To Flash: Finished SAVING to flash

Save Completed

* The save command stores the Faval

downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.




7. Appendix Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to

reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File

Create a Configuration File to save
parameters you have changed.

Right-click Configuration in the Solution
Explorer pane, and select Generate
Configuration File.

A Configuration File is added to
Configuration.

L [REED-1SN01L-ECT] (1001) il Solution Explorer v ix

e W - s -
z

— Search Solution Explorer (Ctrl+;)
] R88D-1SN

b [ System

b [ Clanguage

[ ECATConfig.cfg
2] enizmi Scopeto This

[ pp_custom_save.tpl 0| i
2] pp_disable.t
2 pp.inc_disableset Upload Config Files
=] pp_inc_startup.bet Douo
[ pp_save.cfg
=] pp_startup.ixt
[ systemsetup.cfy
b 4 Documentation
b [ Log
b [ PMAC Seript Language

[ pp_custom_save.cfg B New Soluticn Explorer View

Generste Config File

| 4 ¥ Configuration —— [NENEUW d

Alt+Enter

2 Enter a file name in the textbox, then click
the OK button.

r ™y
@ po_dificfg [

Pleaze tvpe a name for the Config File.

O |

3 Right-click on the Configuration File, and
from the menu, select Check To Download
Config File to include it in files to be
downloaded.

[ pp_save.cfg
=] pp_startup.bet
HAA[] M o
0 € Open
P D Open With...
P [F Lg
4 [P ¥ View Code
4 [ Scope to This
New Solution Explorer View

Exclude From Project

Selution Ex
s Copy Ctrl+C

X Delete Del

R88D-1SM Rename

o= B4 || Check To Download Config File
B FileEnc & properties Alt+Enter
Enable Enu_-,-puuu ™D

B Misc
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4 Saving a Project

In the File menu, run Save All to save the
project on the computer.

@ res0-15n - powerpmac 042119 (I
File

it View Project Build Debug Tools DeltaTau B

Mew 3 -

Debug
Open * K5 Position [0

I
o

Close Project
Upload Project From PowerPMAC

CtrlsS
CtrlsShift«5
Export "
Impart 3
Page Setup..
Print... Ctrls P
Recent Projects and Solubions 3
Exit At Fid

Moter[1].Idata[11]=1176256512
Motor[1].Idata[12]=1188741128
Motor[1].Idata[13]=@
Motor[1].Idata[14]=8
Motor[1].Idatal15]1=0
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I 7.2. Loading and Downloading a Project

1 Start Power PMAC IDE, and
connect to the Controller.

In the Terminal tab page, type the
$$$*** command to reset the
Controller settings to factory
default.

2

Terminal

|$$$—x*1|
PowerPMAC Messages [EgIGED

Terminal Output

In the File menu, click Open —
Project/Solution to load the
project that you saved.

@ PowerPMACIDE42119 £ 1p: 192168.0.200 Type: MOTION CO|

File | Edit View Debug Tools DeltaTau EtherCAT Window Help
Ll L |
' ¥
Open * |8 Project/Solution... Ctrl+Shift+ 0
sy S File.. Ctrl+0
Close Project
Upload Praoject From PowerPMAC
Save Selected frems Ctrl+5
Save Selected ltems As...
W Save Al Ctrl+Shift+S
Export 3
Import 3
Page Setup...
Print... Ctrl+P
Recent Projects and Selutions 3

Exit Alt+F4

Right-click Configuration in the
Solution Explorer pane, and select
Download Config Files to
download the file to the Controller.

____ - EE=pe

v 1 X
ES T,
= @ oo L=
—{f Search Solution Explorer (Ctrl+;) P~
1 R88D-15N
P [ System

P [ Clanguage

| 4 B Codfiquation |

[ Add »

Scope to This
I MNew Selution Explorer View

5/ Properties Alt+Enter

E Downlead Config Files ﬂ

E Generate Config File
+ [ REED-15N.cfg
[ systemsetup.cfg
I [ Documentation
P [d Log
P 3 PMAC Script Language

Solution Explorer
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5 Right-click the project name in the | = oo -~ x

Solution Explorer pane, and i @o-afr-
X —A8 Search Solution Explorer (Ctrl+;) P -
select Build and Download All i R8ED g u
. b L3 Sys S Build
Programs to run the build and b Cacl  Rebuid
4 [ Col Clean
download. oo :
B Mew Solution Explorer View
DI Build and Download All Programs I
. O Map PMAC Vanables
When the download process is 31 R
Complete, make sure that there 3 Export Project with IP Protection...
. ] Export Project Template...
are no errors in the Output A% Ctrlex
. +[1 )
WlndOW o Unload Project
b [3 Doy € Open Folder in File Explorer
E j :;E A Properties Alt+Enter

Selution Explorer

6 Stopping a program

If a program is running, execute
the following command from the
Terminal tab page to stop the
program.

disable plc 1 disable plc 1

ECAT[O] Enable=0 PowerPMAC Messages MEINIGEN Terminal Output

|ECAT[D].EnabIe= 0

PowerPMAC Messages EUIGEN Terminal Output




7 Saving the downloaded settings

and programs

After the download process is
complete and you make sure that
there are no errors in the Output
Window, run the save command
from the Terminal tab page.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal

|sava|

PowerPMAC Messages JIEUUIGEIN Terminal Output

Restarting after download

Run the following command from
the Terminal tab page to restart
the Controller with the
downloaded project.

$$3$

Terminal

Sawving To Flash: Mounting the flash

Saving To Flash: Finizhed SAVING to flash

Save Completed

|sss|

PowerPMAC Messages IIEGUIGEN Terminal Output
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8. Appendix

Troubleshooting

I 8.1. Factors Causing EtherCAT Communications To Be Unavailable, and

Corrective Actions

Description

Factor

Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECATI[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJO].error is set to a
value other than 0.

Check the ECATIO].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from Diagnhosis Mode of Power PMAC IDE.

Right-click on Master0 (Deactivated) under EtherCAT in the Solution Explorer, then select
Diagnosis Mode to open the Diagnosis Mode page

Solution Explorer
@ o-d
Explorer (Cirl+ L -
] R88BD-15N
4 |5y System
b @ CPU

[ Hardware
4 Sy EtherCAT

e

“earch Solution

Diagnosis Mode

Scan EtherCAT Network

Append Slave

& Cq
P [d En ) aste Slave _
b @c l.ar? Import Slaves from ENI
b [l Confid )
b [Ca Docus Export EMI File
b 3 Leg Load Mapping to PowerPMAC
4 [& PMAQ Load Mapping to PowerPMAC Fram ENI
4 |55 Gl
O Activate EtherCAT
| Edit Topology
. - !{,I.r EoE Endpoint Configuration
Solution Explod

c Open

Properties Scope to This

MasterQ (Dea 5] New Solution Explorer View

of B4 | F | & properties Alt+Enter
B Misc

EtherCAT License Matars = 256

File Name Master( (Deactivated)

Fuill Patk CiUsers deltatau’Docurnents), P owerPh

tack Type Acontis

You can check the status of the slaves in the Diagnosis Mode page.



ECATMap.pmh + 3 QUEESWEOE-TaO 0 )R global definitions.pmhb
Device Editor

System

State Machine

Current State Pre-Op

Requested State Pre-Op
Init

Change State Pre-Op
Op

Information
MNumber of found slaves 2

Mumber of slaves in configuration 2

Mumber of DC slaves 2

DCin-sync WVes
Topology Ok Ves
Link Connected Ves
Slaves in Master State Yes

MNetworks: 1 | Slaves: 2 |

Bootstrap

Safe-Op

Frame Counter
Sent frames
Lost frames
Cyclic frames

Acyclic frames

| General | Process Data Image " Watch list ” Performance " Variables ” CoE Object-Dictionary " History|

55067
1]

44678
10389

Clear counters

State: @ @

Mode: DIAGNOSIS

8.2.2. Checking the Controller Status
In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,

and system.

To display the Status page, click Status on the toolbar.

M Global Status

You can check system errors such as the WDT error.

Status

Global Status
Description Status
BufSizeErr False
CenfigloadErr False
Default True
FileConfigErr False
FlashSizeErr False

Motor Status | Coordinate Status Global Status Mﬂi‘.(RC Status |

Description
HWChangeErr
NoClocks
ProjectLoadErr
PwrOnFault
WDTFault

Status
False
False
False
False
NoFault
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M Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Status

Motor 1 |-

Description

AmpFault
AmpWarn
AuxFault
BIDir
BlockRequest
ClosedLoop
Csolve
DacLimit
DesVelZero
Encloss
FeFatal
FeWarn
GantryHomed
HomeComplete

HomelnProgress

® Motor activated

Motor Status I Coordinate Status] Global Status] MACRO Status 1

Status Description
LtFault

False InPos

False InterlockStop
False LimitStop

Plus MinusLimit
False PhaseFound
False PlusLimit

False SoftLimit

False SoftLimitDir
[T seftMinusLimit
False SoftPlusLimit
False SpindleMotor
False TraceCount
False TriggerMove
False TriggerNotFound
False TriggerSpeedSel

Status
False
False
False
False
False
False
False
False
Plus
False
False
False
0
False
False
MaxSpeed

A X

M Coordinate Status
You can check deviation errors, limit errors and other states of the coordinate system.

Status *AXx

Motor Status  Coordinate Status lG\obaI Status] MACRO Status ]
Coordinate System 0 =
Description Status Description Status -

AmpEna False LookAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookAheadFlush False
BlockActive False LookAheadlookBack False
BlockRequest False LookAheadReCalc False
BufferWarn 0 LookAheadStop False
CC3Active False LookAheadWrap False
CCAddedArc False MinusLimit False
CCMode Off MoveMode LineCircle
CCMoveType Dweell PlusLimit False
CCOffReq False ProgActive False
ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegHaltReq False
Encloss False SegMove Off
EndDelayActive False SegMovelccel False
ErrorStatus NoError SegMoveDecel False
FeedHold Off SegStopReq False
FeFatal False SharpCornerStop False
FeWarn False SoftMinusLimit False
HomeComplete False SoftPlusLimit False
HomelnProgress False TimerEnabled False
LRtFault False TimersEnabled False
InPos False TriggerMove False
InterlockStop False TriggerMotFound False -
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9. Appendix ECAT]Ii] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT

controllers.

Element name

Description

Change

ECATIi].Enable

ECATIi].LPIO[K]

ECAT[i].Slave[]]
ECAT[i].Error

ECATIi].LinkUp
ECATIi].LPDomainOutputState
ECATI[i].LPDomainState
ECATI[i].LPRxTime
ECATI[i].LPTxTime
ECATI[i].MasterStat

ECAT[i]. RTDomainOutputState
ECATI[i]. RTDomainState

38

Enabling the EtherCAT
network

Elements of low priority
I/O module

Slave elements

Error code of enabling
EtherCAT network

Status data structure
elements

0: Disable, 1: Enable (2 and 3 are not
supported.)
Not supported

Not supported

$ 9811000C: Invalid network
configuration

$ 9811002E: Disconnected network
connection

Not supported
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